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Installation and maintenance
1 Installation and maintenance
System requirements
Starting the setup program
Installing the program - installation steps
Language Selection dialog box
Welcome dialog box
User Information and User Rights dialog box
Target Folder dialog box
Installation Type dialog box
Starting the installation
Uninstalling or customizing the program
Application Maintenance dialog box

1.1 System requirements
The following hardware and software components are required to install and run the program properly:

• PC, IBM compatible, at least Pentium processor, 166 MHz, 
• 64 MB RAM, 
• 20 MB free hard disk space, 
• SVGA card, at least 256 colors, 
• Windows 98, NT 
• CD-ROM drive for installing the program
• InternetExplorer Version 5.01 or higher

1.2 Starting the setup program
Insert the CD in your CD-ROM drive. The setup program will be started automatically. You can also start 
the setup program manually by following the instructions below: 

On the CD you will find the Setup.exe program in the roots directory.

Double-click on Setup.exe to start the setup program. The Windows Installer dialog box appears. If the 
Windows installer should not yet be available on your system, it is automatically installed then. After this, 
your system needs to be restarted. After the restart the setup program will start again automatically to 
continue the installation. Note: Some systems do not permit an automatic restart of the setup program. 
In this case, manually start Setup.exe as described above. 

1.3 Installing the program - installation steps

1.3.1 Language Selection dialog box
When the setup program has been started, the Language Selection dialog box will pop up. In this dialog 
you can select the language for both theR&C Process Data Management and the installation program.

Select a language from the list and confirm with OK to continue. (Note: The selected language can be the 
same as your system language, but does not need to be). 

1.3.2 Welcome dialog box
A setup wizard started with a welcome screen will help you to install the program. To ensure proper in-
stallation it is strongly recommended to exit all other applications before running the setup program. Be 
sure that this is case before selecting "Next". Otherwise, the current setup procedure should be can-
celled. 
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Installation and maintenance
1.3.3 User Information and User Rights dialog box
Enter your full name and organization in the respective fields. 

Note that special user rights can only be assigned by the system administrator of the PC on which the 
software is to be installed. 

If the menu option "All users" is selected, the program will always appear in the start menu, no matter who 
is currently logged on. 

When selecting the "Me only" option the program will only appear in the start menu when you are logged 
on under your personal account. 

1.3.4 Target Folder dialog box
In this dialog you can define the target drive and folder in which the program is to be installed. Click on 
the "Browse" button to change the default drive and folder. 

1.3.5 Installation Type dialog box
In this dialog box you can select to install Typical, All or Custom products. 

Typical 
Installs the R&C Process Data Management with the following products: Modbus, Visu, Konfi Device 
Type Manager (DTM) for Datavis for device configuration and control (Prog1 and Prog2 functionality) 

All
Installs all products

Custom
Product selection as required. You can select the products you want to install from the next dialog box. 

1.3.6 Starting the installation
When all necessary entries and settings have been made, you can start installation. The installation pro-
cedure may take some time. When installation is complete, a message appears indicating that the instal-
lation was successful. The menu item "R&C Process Data Management " is now available in the start 
menu.

1.3.7 Uninstalling or customizing the program
There are two possible ways to uninstall the program or to install/uninstall specific program components: 

• Start the Setup.exe program or
• Select [Settings -> Control Panel -> Add/Remove Programs] from the Start menu and then double-click 

on the "R&C-Process-Data-Management " option.

In both cases the Setup program is started, and the Application Maintenance dialog box appears.

1.3.8 Application Maintenance dialog box
This dialog box provides several service and maintenance options for your program: 

Customize
Add or remove components

Repair
Re-install or add components that have been purchased at a later time

Uninstall
Completely uninstall the program. 
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Workspace
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Starting the workspace
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Project and project tree
Working with the project tree (Edit current project)
Editing the project name
Creating a new element in the project tree
Creating a device
Integrating external applications
Editing remarks
Linked documents
File menu
Creating a new project
Opening an existing project
Saving the current project
Saving a project under a new name
Saving a copy of the project
Sending a project to
View menu
Dialog language
Showing/hiding the toolbar and status bar
Showing/hiding the project view
Project menu
Defining the fieldbus segments
Options
Help Menu

2.1 R&C Process Data Management Software
The R&C Process Data Management Software from ABB Recording & Control includes the following PC 
software packages for measured value processing: 
• Modbus OPC Server (DA 2.0 Standard),
• Device Bus OPC Server (DA 2.0 Standard) for devices that exclusively support the H&B Device Bus 

(from version 3 and higher)
• Process Data Visualization (OPC client)
• OPC HDA Server for recording and handling historical values (from version 3 and higher)
• R&C Process Web Server for process data visualization via the Internet (from version 3 and higher)
• FDT Device Configurator and Device Type Manager for device management and configuration

The following tasks for small automation applications are fully covered by this software: 
• Process data acquisition 
• Archiving (from version 3.0 and higher)
• Visualization
• Device management and configuration

All products of the R&C Process Data Management Software use the following standards and trends of 
advanced process automation: 
• OPC (OLE for Process Control) for process data acquisition, 
• OPC-HDA (Historical Data Access) for process data archiving (Version 3 and higher)
• Web and browser technologies  (HTML, DHTML, JavaScript, ActiveX components technology, etc.) for 

process data visualization
• FDT (Field Device Tool) Standard for device configuration

Due to its compliance with the above-stated standards the R&C Software Suite is an open system pro-
viding the following features: 
• trouble-free cooperation of different software packages
• preservation of you investment in already purchased ABB devices
• integration of bus-compatible devices from other vendors
• integration of OPC servers for other fieldbuses (e.g. Profibus, FoundationFieldbus, InterbusS etc.) 
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Workspace
• free access throughout the network to all process data on recorders, controllers and indicators from pro-
cess control systems or other visualization systems

2.2 Workspace and software concept
All software packages of the R&C Process Data Management Software share a common R&C instrumen-
tation software library. The library is installed with the first product of the software suite, and may be up-
dated if required when a new product of the R&C Process Data Management software package is 
installed. Among other items the library contains all communication components like OPC and FDT. 

To ensure user-friendliness and convenient control all software packages use a common graphical user 
interface, the so-called workspace. This does not apply to the ProcessWebServer which does not need 
a user interface. The workspace is installed with the first product of the software suite, and may be up-
dated if required when a new product of the  R&C Process Data Management software package is in-
stalled.

2.3 Starting the workspace
The menu item "R&C Process Data Management Software " is available in the start menu under "Pro-
grams". Click on the "Workspace" menu item to start the program.

2.4 Workspace components
After starting the workspace the user interface appears (refer to the illustration). The project tree is dis-
played in the left section of the window. It is the main tool for navigating and for controlling the installed 
software packages. Moreover, it is the starting point for all functions related to data acquisition, visualiza-
tion and device parameterization. The right sub-window is the Web browser display area, where any Web 
site selected can be displayed. The installed and licensed software packages are shown here by default.

Fig. 2-1 Work space components
8 Modbus OPC Server DA200M, R&C Process Data Management Software 42/49-28 EN



Workspace
2.5 Project and project tree
The project tree is the main tool for navigating and is used for organizing and handling all devices, plants 
and applications in a structured hierarchy, as seen in the illustration. 

Example
The example shows a plant hierarchy in the project tree. The project may contain any number of folders 
and subfolders. Devices, visualization pages and subfolders can be arranged in every folder such that 
they represent the structure of the actual plant.  

Fig. 2-2

2.5.1 Working with the project tree (Edit current project)
Upon loading or creation of a project the project tree can be designed or adapted freely to meet the re-
quirements of the respective application. You can create hierarchies, change names, and add elements 
like plants, devices, servers or visualization pages. 

Fig. 2-3

All these action can be performed in the project tree. Right-click on the appropriate node in the project 
tree. A shortcut menu adapted to the respective node type appears, where all actions can be performed. 

2.5.2 Editing the project name
Right-click on the root directory. Select "Rename" from the shortcut menu that appears. You can edit the 
project name directly in the tree view, then. 

Note As a rule, every element in the project tree can be renamed in this way.
42/49-28 EN Modbus OPC Server DA200M, R&C Process Data Management Software 9



Workspace
2.5.3 Creating a new element in the project tree
Right-click on the folder icon to open the shortcut menu. Then select "New". A pull-down menu with var-
ious options for creating a new project element will pop up. The following menu options can be selected: 

Folder
Creates another hierarchy level, where other elements can be. 

Device
Creates a new device. The device type can be selected from a device selection list. The selection list con-
tains all Device Type Managers (DTMs) installed on your PC and the virtual devices like the R&C Modbus 
OPC Server. 

External application
Permits to integrate any external 32-bit program, e.g. Paraline200. This feature is especially designed for 
supporting devices for which no DTM complying with the FDT standard exists yet. 

Visualization page
Permits to create visualization pages by using one of the 11 pre-configured standard visualization pages 
as a template, and to integrate user-defined HTML pages.

Fig. 2-4

2.5.4 Creating a device
Right-click on the folder icon to open the shortcut menu. Then select "New". A pull-down menu with var-
ious options for creating a new project element will pop up. Select "Device (by type)" to open the dialog 
box for selecting the device type (see the illustration (see Fig. 2-5). 

Fig. 2-5
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Workspace
Select a device from the list of available devices. Press the "Create device" button to confirm. The device 
will be created in the selected folder with the name "New device". Directly upon creation the edit mode 
will be active, i.e. you can change the node name according to your needs. 

Note The name is freely configurable, independent of the device type. Names like "Datavis-1", "Datavis (heater 
A)", or simply "Tag 01" are valid without any limitations.

Double-click on the menu item to start the device-specific Device Type Manager with all parameter defi-
nitions of the device. See topic "Device Type Manager" for details.

2.5.5 Integrating external applications
The program permits to integrate any external 32-bit program, e.g. Parapoint200. This feature is espe-
cially designed for supporting devices for which no DTM complying with the FDT standard exists yet. You 
can also integrate any other 32-bit program, e.g. Excel. 

Right-click on the folder icon to open the shortcut menu. Under "New" a select list for creating a new 
project element can be called up. Select "External application". The dialog box for integrating external 
programs appears.  

Fig. 2-6

Command line
Enter the program name with full path information in the command line.

Work directory:
If you don't want to use the program folder as your work directory, you can enter a path for your work 
directory here.

Confirm with OK. The new item appears in the tree. Double-click on the item to start your application.
42/49-28 EN Modbus OPC Server DA200M, R&C Process Data Management Software 11



Workspace
Editing remarks
A remark can be stored for every node in the project tree. Select the "Remarks" menu item from the short-
cut menu to open the Remarks dialog box. 
You can enter simple texts without attributes in this dialog box. Confirm with OK. The text is taken over 
and allocated to the node. 

Fig. 2-7

Linked documents
Documents like operating instructions for the device, logs, etc. can be linked with every node. Click on 
the "Linked documents" menu item to open the "Documents linked with this element" dialog box where 
you can add, remove or open documents. 

Fig. 2-8
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Workspace
2.6 File menu
The workspace offers a project management function for creating, loading and saving projects. This al-
lows you to work with different projects. The file menu of the workspace (see illustration) is used for 
project management (see Fig. 2-1).

Fig. 2-9

2.6.1 Creating a new project
In order to create a new project open the File menu and select "New". If you have already opened a 
project and have not yet saved it, you will be asked if you want to save that project before creating a new 
one. If yes the File dialog box appears, if no the current project is closed without saving, and the new 
project is created immediately. 
The new project is first created with the default name "New project", which can be changed as required. 
Refer to the topic "Editing the project name" for details.

2.6.2 Opening an existing project
In order to open an existing project open the File menu and select "Open...". If you have already opened 
a project and have not yet saved it, you will be asked if you want to save that project before opening an-
other one. If yes the File dialog box appears, if no the current project is closed without saving.  The "Open 
file" dialog box appears where you can select the respective file and then load it into the workspace. 
Project files have the extension ".ids".

2.6.3 Saving the current project
In order to save the current project open the File menu and select "Save". The project will be saved with-
out further prompts. If the project is saved for the first time, the "Save as" dialog box will appear, where 
you can enter a new name for your project. 

2.6.4 Saving a project under a new name
Select the "Save as..." menu option from the File menu if you want to save the current project under a 
new name. The "Save as" dialog box will appear, where you can enter a new name for your project. After 
this the project will appear in the workspace under the new name.

2.6.5 Saving a copy of the project
Select the "Save copy as..." menu option from the File menu if you want to save a copy of the current 
project under a new name. The "Save as" dialog box will appear, where you can enter a new name for 
your project. The project name that already exists in the workspace will not be changed. 

2.6.6 Sending a project to
Under "File" -> "Send to" "E-mail address" you can send you project as an e-mail to an addressee. The 
mailing program is opened. A new mail is created automatically, and the project file (.ids) is already at-
tached to it. Enter an e-mail address and send off the mail.
42/49-28 EN Modbus OPC Server DA200M, R&C Process Data Management Software 13



Workspace
2.7 View menu
In the View menu you can adapt the workspace to your needs. You can select the dialog language and 
show/hide the toolbar, the status bar, and the project tree (Project view). 

Fig. 2-10

2.7.1 Dialog language
Select the "Change language" menu item to change the dialog language. The "Change language" dialog 
window appears.

Fig. 2-11

Select a language from the list of installed languages and confirm with OK. The new language setting will 
be activated when the program is started the next time. Terminate/restart your program. 

2.7.2 Showing/hiding the toolbar and status bar
Click on the "Toolbar" menu item to show/hide the toolbar. 
Click on the "Status bar" menu item to show/hide the status bar.

2.7.3 Showing/hiding the project view
Click on the "Project view" menu item to show/hide. 
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Workspace
2.8 Project menu
In the project menu you can set the project-specific parameters.

Fig. 2-12

2.8.1 Defining the fieldbus segments
A fieldbus segment represents the configuration of serial PC or bus segment interface. If the PC has sev-
eral serial interfaces, you can define several fieldbus segments with different settings (e.g. for the baud 
rate). In the device configuration a fieldbus segment can be allocated to the respective device. 

Select the "Define fieldbus segment" menu item from the "Project" menu. 
A dialog box appears where the defined fieldbus segments are listed. 

Fig. 2-13

Select the name of the link, the protocol (under fieldbus type) and the COM interface in the "Fieldbus seg-
ment" dialog box.

Fig. 2-14
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Workspace
Click on "Edit". 
A window appears, where you can define the interface settings: RS 232 or RS 485, baud rate, etc. 

Remark Usually, RS 232 is the correct setting, even if the device is connected to the RS 232 interface of your 
computer via an  RS 485 converter. RS 485 has to be selected only if a so-called hardware flow control 
is required, e.g. for a non-automatic RS 485/RS 232 converter. 

2.8.2 Options
In the Project options dialog box you can define that the last accessed project is automatically opened 
when the workspace is started.  

Fig. 2-15

2.9 Help Menu
The Help Menu contains the item Help and Register with that one can open the license dialog.

The Help for the License dialog can be opened by pressing the help button avaliable on this dialog.

Comment The Licensing software is a common ABB software independent of the R&C Process Data Management. 
This is the reason why it has his own separate help. 
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3 OPC server for Modbus-RTU
OPC (OLE for process control)
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Modbus shortcut menu
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OPC item list
Device settings
Add new group
Add new element
OPC-ItemID Properties dialog box
Enabled
Name
Description
Read access to Modbus registers
Read access to Modbus registers
Data type
AND bit mask for BOOLEAN values
String length and character format
Scaling, standardized range
Units
Scan rate

3.1 OPC (OLE for Process Control)
What is OPC?
OPC is intended to standardize the data access via standardized interfaces. 

In the beginning, every software and application engineer had to develop proprietary interfaces, servers 
or drivers to realize the data exchange with fieldbus devices. The problem was due to the great variety 
of different fieldbus devices, bus systems and data acquisition stations available on the market, which 
eventually resulted in proprietary solutions that were not compatible with each other. The OPC approach 
defines a common, open interface doing away with the need for special proprietary drivers. OPC permits 
standardized access to any fieldbus for all HMI, SCADA, and open control systems. 

Thus, OLE For Process Control (OPC) provides for standardized data exchange between heterogeneous 
process automation instruments and the most different PC applications. Object Linking and Embedding 
(abbr. OLE) is a software interface that can implement and display the information from one program in 
another application. OPC is supported by the OPC Foundation who has worked out the technical speci-
fications and has already more than 140 members, among them global players like ABB, Siemens, etc. 

3.2 Modbus OPC DA Server
The Modbus OPC server scans process data from the fieldbus (Modbus) and makes them available to 
the PC world throughout the entire network via an OPC interface. Since OPC is a commonly used stan-
dard in the world of process automation, not only the process data management visualization compo-
nents can be used, but - and this is the real benefit of OPC - all OPC-compatible client applications from 
any vendor.
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3.2.1 Notes on installation
When the Modbus OPC server is installed, the work environment common to all R&C Process Data Man-
agement products is automatically installed with it. If the environment should already exist, e.g. because 
another product of this family has already been installed on the same system, it is updated if necessary.

3.2.2 Create a new Modbus RTU device
The project tree is used to create a node for each Modbus-compatible device. This node represents the 
device in the tree view, then. 
Right-click on the folder icon to open the shortcut menu. Then select "New". A pull-down menu with var-
ious options for creating a new project element will pop up. 
 

Fig. 3-1

Select "Device (by type)" to open the dialog box for selecting the device type (see Fig. 3-2).

Fig. 3-2

Choose "Modbus RTU device" from the list box and click on the "Create device" button to exit the dialog 
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box and create a new Modbus device node in the project tree. 
Directly upon creation the edit mode will be active, i.e. you can change the node name according to your 
needs. 

Note The name is freely configurable, independent of the device type. Names like "Datavis-1", "Sm2000 (Mod-
bus RTU)" or simply "Tag 01" are valid without any limitations.

3.2.3 Modbus shortcut menu
Right-click on the Modbus device node to open the Modbus shortcut menu.

Fig. 3-3

The menu options "Remarks", "Linked documents", "Delete", "Rename", and "Select fieldbus connection" 
are general subjects and shall not be further described here. Refer to the online help of your work envi-
ronment for details.

3.2.4 Configuration
Clicking on the "Configuration" option will open the Modbus Configuration dialog box.

3.2.5 OPC communication enabled
This switch is set to "enabled" by default (tick to the left of the text). Enabled means that the defined pro-
cess variables of the device are available among the OPC names on the OPC server and can be ad-
dressed from an OPC client. 

Disabling OPC communication may be useful when a configured device shall temporarily not be addres-
sable for a certain reason.

3.2.6 Import configuration file
This import function allows you to load user-defined or predefined OPC Modbus configuration data sets. 
Configuration templates are available for the following device types: 

Compact controllers:
• Digitric 100
• Digitric 500
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• Protronic 100
• Protronic 500/550

High-voltage current transmitters:

• SU

Process recorders:
• Linemaster 200
• PointMaster100 and 200

3.2.7 Export configuration file
This function permits to export a created OPC Modbus configuration data set as a text file. This means 
you can re-use a definition created for a special Modbus device type as a template for other devices of 
the same type.

3.2.8 Modbus Configuration dialog box
Double-click on this menu item to open the Modbus Configuration dialog box where you can create or 
edit the Modbus parameters needed for communication with the device (e.g. bus address, Modbus reg-
isters, etc.). 

Fig. 3-4

In the left section of the window the tree view with the OPC groups or the Modbus register structure of 
the device is indicated. In the right section of the window the OPC elements and the references to the 
Modbus registers in the OPC item list are displayed.

OPC item list
Description of the list elements
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Name
The OPC item name is the most right or last part of the hierarchically organized OPC item ID referred by 
the OPC client.0 
Example

ABB.IM.OpcServer.1\P500-1 (Modbus RTU).P5X0a_Regs_Lx.L1_WSOLL0

To the left of the name you can find a checkbox. By checking/unchecking the box you can enable/disable 
an OPC item for browsing and accessing on the OPC server and in the OPC name area. Usually, a device 
has considerably more process variables than are needed for the respective application. For example 
Protronic 500 has approx. 1800 process variables; only some (e.g. 5 - 20) are polled at all. 

Registers
The Modbus registers linked with the OPC item name.

FC
The Modbus function code (FC) for polling the Modbus registers.

PV
Current process value (PC), provided that the preview has been enabled.

Device settings
Click on the "Device settings" button to open the "Device properties" dialog box where the Modbus prop-
erties of the device are defined.

Fig. 3-5

Supported function codes
In the Modbus world the access type to a Modbus device is defined by using so-called functions codes 
of the bus protocol. Which function codes are supported can be derived from the Modbus specification of 
the device. Click on the checkbox to select the supported codes.

Word swap
For data types requiring more than 16 bits for display, e.g. LONG, ULONG, REAL4 and REAL8, various 
transmission orders for the 16-bit registers have become established for Modbus. In order to support all 
possible combinations, the Modbus server permits to change the register order during re-interpretation 
(word swap). 
The following table gives an example for the re-interpretation of registers Reg101 to Reg104 with and 
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without word swap.

LOW represents the least significant word, HIGH the most significant word..

Telegram bundling
If the Telegram bundling checkbox is ticked, the Modbus server compiles all subsequent registers in a 
telegram to improve the bus performance. 

Example:
The registers 101,102, 103, 104, 107, 108 are to be polled from the Modbus device. 

If telegram compilation is disabled, 7 request telegrams are transmitted, and 7 response telegrams are 
returned. Since a Modbus telegram frame consists of at least 8 bytes, performance is low. 

If telegram compilation is enabled, the subsequent registers a polled within one and the same telegram, 
and only one response telegram is returned. In the example the registers 101 to 104 are polled together 
by a single telegram. The same is valid for the registers 107 and 108. This means that only two request 
and response telegrams have to be transmitted, and the performance is improved. 

In the case described in the example it would also be useful to poll the unused registers 105 and 106 as 
well to save another request/response telegram. 

Note • Process variables with different scan rates cannot be compiled. 
• The client (e.g. visualization) must really poll the registers. A definition in the OPC name area does not 

suffice for telegram compilation.

Default scan rate
This input field is used to define a default scan rate for all process variables. Note that it is also possible 
to make individual settings for every process variable (see OPC ItemID properties - Scan rate)

Use simulated values
not yet implemented

Response time
Defines the maximum time which the Modbus device may need to start responding to a transmitted re-
quest protocol. In case of time-out the request is cancelled. 

Pause after request
Defines the waiting time after termination of a Modbus action (request telegram + response telegram or 
timeout) before a new request can be started. 

Add new group
Within the OPC name area groups represent the logical arrangement of a device's process variables. The 
groups can be arranged in a hierarchy of arbitrary depth. 

Right-click on a folder or group node to open the shortcut menu. Select the "Add new group" option. A 
group node called "New group" is created and added to the tree. Enter an unambiguous name for this 
group, e.g. a name representing the device structure. You can edit this name at any time by calling up 
the shortcut menu for the node. 

Add new element
In the OPC name area the elements are the actual representation of the process variables, whose values 
and properties will then be accessed by an OPC client (e.g. visualization). 

Right-click on the element area in the right section of the window (OPC item list). The respective shortcut 
menu will be opened. Select the "Add new element" option. The "OPC ItemID Properties" dialog box ap-
pears. Refer to the respective help window for details about this dialog box.

Data type Interpretation without word swap Interpretation with word swap
LONG LOW       HIGH  

|Reg101|Reg102|
HIGH     LOW  
|Reg101|Reg102|

ULONG  LOW      HIGH 
|Reg101|Reg102|

HIGH     LOW  
|Reg101|Reg102|

REAL4 LOW      HIGH 
|Reg101|Reg102|

HIGH     LOW  
|Reg101|Reg102|

REAL8 LOW . . . . . . . . . .HIGH 
|Reg101|Reg102|Reg103|Reg104|

 HIGH . . . . . . . . .LOW 
|Reg101|Reg102|Reg103|Reg104|
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3.2.9 OPC-ItemID Properties dialog box
Usually, an interface description or the Modbus register description of the device is needed to fill in this 
dialog box. 

Fig. 3-6

Enabled
By checking/unchecking the box you can enable/disable an OPC item for browsing and accessing on the 
OPC server and in the OPC name area. Usually, a device has considerably more process variables than 
are needed for the respective application. For example Protronic 500 has approx. 1800 process vari-
ables; only some (e.g. 5 - 20) are polled at all.  

Name
Under this name the process variable is stored in the OPC name area, together with the other group 
members. 

Description
Used for easy identification of a process variable.

Read access to Modbus registers
Read function code
List box for selecting a function code (FC).
Refer to the Modbus description of the device for the function code for read access. 

Read register
Address of the Modbus register. Refer to he Modbus description of the device. 
The address area of the Modbus server permits values between  0 (0000H) and 65535 (FFFFH). 

Note: The Modbus register count of the devices is vendor-specific and, therefore, may be unambiguous. For 
some devices it starts with 1, i.e. the first Modbus register must have the register address 0, which is usu-
ally also used for bus communication. 
The present Modbus OPC server works directly with the register addresses, starting with 0, and does not 
use the register numbers. Therefore, it is possible that an offset of 1 must be subtracted from the number 
stated in the register description, depending on the device.
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Write access to Modbus registers
Writeable
Switch for selecting whether or not the Modbus register shall be writeable by using the OPC reference 
specified under "Name". If this feature has been enabled, it is possible to transmit values to the device 
via the Modbus OPC server, by using the bargraph display or the numerical display of the R&C visualiza-
tion package (OPC client).

Write function code
Indicates the write function code for the selected read function code.

Write register
Address of the Modbus register which is to be written on. Refer to the Modbus description of the device 
for the register address.

Data type
The following data types are available for the Modbus communication:

AND bit mask for BOOLEAN values
An AND bit mask can be used for Boolean values to filter specific bits of a Modbus register. 

Example:  
The bits B2 and B9 of the read register 120 (FC3) are evaluated for the Boolean process variable 
IO_ALARM. It shall be determined, whether or not the bit (B2 or B9) has been set.

REG120 01101101 10111111 6D BF 
UND 00000010 00000010 02 02 

––––––––– –––––––––   ––––– 
= 00000000 00000010 00 02

The result is interpreted as seen belowt:

         Wert gleich   0  =>  FALSE
         Wert ungleich 0  =>  TRUE

In this case the value of the process variable IO_ALARM is set to TRUE .

Data type 
name

Description Other common 
designations

SHORT 16 bit integer, signed, complement of 2 SHORT INT

USHORT 16 bit integer, unsigned WORD
LONG 32 bit integer, signed, complement of 2 LONG INT

ULOG 32 bit integer, unsigned DWORD

REAL4 4 byte floating point number (IEEE 754) FLOAT
REAL8 8 byte floating point number (IEEE 754) DOUBLE

BOOLEAN 1 bit within one register or one Modbus coil COIL

STRING Character string with fixed length –
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String length and character format
Modbus reads strings of constant, predefined length. In the "String length" input feld the number of char-
acters to be read (Caution! Not the number of Modbus registers to be read) is defined. 

Due to the 16-bit structure of Modbus registers the formats of character strings are device-specific and 
different. They can be defined by using the "Character format" list.

Remark H: Register-High-Byte, L: Register-Low-Byte

Scaling, standardized range
Modbus devices often directly provide the physical measuring variable (e.g. temperature value in degrees 
Celsius) via the Modbus. Usually, no further scaling is required.

It is, however, also commonly used to output a standardized value (e.g. between 0 and 1 or between  0 
and 65535, etc.), which covers the entire value range from the start of scale to the end of scale. To come 
to the physical value, the standardized value (raw value) must be mapped to the physical value, e.g. 
[0...1] corresponds to [-150 °C...+200 °C].

Standardized range
The standardized value range of a process variable is entered in the two input fields labeled "Technical". 
The standard range defines the start and end of scale values which are polled from the OPC server during 
initial configuration of a visualization page. These are then used for drawing the scale in the analog visu-
alization elements (bargraph display, line chart, analog display). 

Scale
Switch for defining whether or not the raw value is to be scaled.

Mapping function
The mapping function is defined by the raw value with "Start" and "End" that is mapped to the technical 
value with "Start" and "End". The following calculation formula is used:

 

T phys. value
Ta phys. start of scale
Te phys. end of scale
R raw value from Modbus device
Ra min. raw value
Re max. raw value

Scaling via register
Instead of manually entering the start and end of scale values, these values can also be polled from the 
device via Modbus, provided that the device supports this functionality. 

You can enable the "..." button for register definition by ticking "via register". Upon actuation of this button 
the "External scaling" dialog box appears where you can set the register, data type and register type for 
reading the scale. 

Note The scaling registers are static device data that are read once during the first OPC client access after the 
server has started. 

To read the static register again, open the Modbus Configuration dialog box of the device and confirm 
with "OK". This will refresh the OPC name area for the respective device, and the registers are re-read.

String format Description Example 
"SETP1", string length=3

1 character/register 1 character per register: the cha-
racter resides in the low byte of the 
register

Register:  |1 |2 |3 |4 |5 | 
Reg.-Byte: |HL|HL|HL|HL|HL| 
Example:   | S| E| T| P| 1|

2 characters/register AB 2 characters/register: first charac-
ter in high byte (H), next character 
in low byte (L) of the register.

Register:  |1 |2 |3 | 
Reg.-Byte: |HL|HL|HL| 
Example:   |SE|TP|1 |

2 characters/register BA 2 characters per register: first cha-
racter in low byte (L), next charac-
ter in high byte (H) of the register.

Register:  |1 |2 |3 | 
Reg.-Byte: |HL|HL|HL| 
Example:   |ES|PT| 1|

T Te Ta–( ) R Ra–
Re Ra–
-------------------× Ta+=
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Units
Defines the physical unit of the process variable (e.g. m³/h etc.). 

The unit can also be read directly from the device as a string, provided that this function is supported by 
the Modbus device (refer to the device's Modbus description). 

You can enable the "..." button for register definition by ticking "via register". Upon actuation of this button 
the "External unit" dialog box appears where you can set the register, string length and character format 
for reading the unit. Refer to "String length and character format" for more details.

Scan rate
The scan rate is defined for all process variables together under "Device settings"-"Default scan rate". 

If a specific scan rate is to be defined for the process variable, this is done by using the "Scan rate" se-
lection box. 

The scan rate represents the minimum time intervals at which the Modbus server attempts to poll the pro-
cess variables. This time interval can be prolonged, e.g. if the response times of the devices on the bus 
are too long and the total of all telegrams exceeds the scan rate time, or if a communication error occurs.
ABB Automation Products GmbH
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Germany 
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